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Imprint

© All rights reserved to ELAU AG, also in case of patent right 
applications.

No part of this documentation and the related software and firm-
ware may be reproduced, rewritten, stored on a retrieval system, 
transmitted or translated into any other language or computer lan-
guage without the express written consent of ELAU AG.

Any possible measure was taken to ensure that this product docu-
mentation is complete and correct. However, since hardware and 
software are continuously improved, ELAU makes no representati-
ons or warranties with respect to the contents of this product 
documentation.

Trademarks

PacDrive is a registered trademark of ELAU AG.

All other trademarks mentioned are the exclusive property of their 
manufacturers.

ELAU AG ELAU Inc.
Dillberg 12 4201 W. Wrightwood Ave.
D-97828 Marktheidenfeld Chicago, IL 60639

Phone: +49 (0) 93 91 / 606 - 0 Phone: 773 342 8400
Fax: +49 (0) 93 91 / 606 - 300 Fax: 773 342 8404

eMail: info@elau.de sales@elau.com
Internet: http://www.elau.de http://www.elau.com
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1 On this manual

1.1  Introduction

Before using ELAU components for the first time, you should 
familiarize yourself with this operating manual.

In particular, observe the safety notes described in chapter 2.

Only persons who meet the criteria for "Selection and Qualification 
of Staff" (see chapter 2.4) are allowed to work on ELAU 
components.

One copy of this manual has to be available for staff working on the 
components with access at any time.

This manual is to help you use the component safely and expertly 
and to use it as directed.

Observe this manual. This will help to avoid risks, reduce repair 
costs and down times and increase the lifetime and reliability of the 
products.

You also need to observe the valid rules for the prevention of 
accidents and for environmental protection in the country and place 
where the device is used.
PacDrive™   page 5
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1.2  Symbols, Signs and Forms of Depiction

The following symbols and signs are used in this document:

Table 1-1: Symbols, signs and forms of depiction

Depiction Meaning

First level enumeration sign.

– Second level enumeration sign.

Action symbol: The text following this symbol inclu-
des an instruction for action. Execute the instruction 
actions in the given order, from top to bottom.

Result symbol: The text following this symbol con-
tains the result of an action.

Italics If the describing text contains special terms (e.g. 
parameters) these are written in italics.

Serif font
If the manual contains program code, this is marked 
by Serif font.

Information symbol: This symbol marks notes and 
useful tips for using the product.

Warning sign: Safety notes can be found in the rele-
vant places. They are marked by this symbol.
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2 General Safety Notes

This chapter contains general requirements for working safely. 
Every person using ELAU components or working on ELAU 
components has to read and observe these general safety notes.

If activities involve a residual risk, you will find a clear note in the 
respective places. The note describes the risk that may occur and 
preventive measures to avoid that risk.

2.1  Basics

The ELAU components are built according to the state of 
technology and generally accepted safety rules. Nevertheless, their 
use may cause a risk to life and limb or material damage if:

you do not use the components as directed

work on the components is not done by experts or instructed 
staff

you inexpertly alter or modify a component

you fail to test the protective measures in place after installation, 
commissioning or servicing

you do not observe the safety notes and regulations.

Only operate the components in perfect technical condition, as 
directed, with regard to safety and risks and observe this manual.

The flawless and safe operation of the components requires 
appropriate transport, storage, mounting and installation as well as 
careful maintenance.

In case of any circumstances that impair the safety and cause 
changes in the operating behavior, immediately put the 
component(s) to a stop and inform the service staff in charge.

In addition to this manual, observe

the prohibiting, warning and mandatory signs on the component, 
the connected components and in the switching cabinet

the relevant laws and regulations

the operating manuals of the other components

the universally valid local and national rules for safety and the 
prevention of accidents.
PacDrive™   page 7
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2.2  Depiction of Safety Notes

Risk categories

The safety notes in this manual are grouped into different risk 
categories. The table below shows which risk and possible 
consequences the symbol (pictograph) and the signal words 
indicate.

Table 2-1: Risk categories

Pictograph Signal word Definition

DANGER!

Indicates an immediately dangerous 
situation that will result in death or very 
serious injuries if the safety rules are 
not observed.

WARNING!

Indicates a possibly dangerous 
situation that can result in serious 
injuries or major material damage if the 
safety rules are not observed.

CAUTION!

Indicates a possibly dangerous 
situation that might result in material 
damage if the safety rules are not 
observed.
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2.3  Use as Directed

The ELAU components are designed for installation in a machine/
plant or for combination with other components to form a machine/
plant. The components may only be used under the installation and 
operating conditions described in this documentation. You must use 
the accessories and ancillary parts (components, cables, etc.) 
mentioned in the documentation. You must not use any foreign 
objects or components that are not explicitly approved by ELAU.

"Use as directed" also means that you

observe the Operating Manuals and other documentations (see 
appendix), 

observe the instructions for inspection and maintenance.

Use other
than directed

The operating conditions at the place where the device is used 
must be checked on the basis of the given technical data 
(performance information and ambient conditions) and observed.
PacDrive™   page 9
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2.4  Selection and Qualification of Staff

This manual is aimed exclusively at technically qualified staff with 
detailed knowledge in the field of automation technology.

Only qualified staff can recognize the significance of safety notes 
and implement them accordingly.

This manual is aimed in particular at design and application 
engineers in the fields of mechanical and electrical engineering, at 
programmers, service and commissioning engineers.

Working on
electrical

equipment

Work on electrical equipment must only be done by qualified 
electricians or by instructed staff supervised by an electrician 
according to the electrotechnical rules.

An electrician is a person who, due to his vocational training, know-
how and experience as well as knowledge of the valid regulations, 
is able to:

evaluate the work he is supposed to do

identify potential risks

implement suitable safety measures.
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3 Overview

3.1  What is EPAS-4?

EPAS-4 is a complete development environment for the PacDrive™ 
system.

EPAS-4 puts a simple approach to the powerful IEC language at 
the disposal of the PLC programmer. Use of the editors and 
debugging functions is based upon the proven development 
program environments of advanced programming languages (such 
as Visual C++).

The PacControl CD contains the documentation for the PacDrive™ 
system in Portable Document Format (*.PDF). The document can 
be read and printed with the enclosed Acrobat Reader program.

3.2  EPAS-4 components

The following table gives you an overview of the components of the 
EPAS-4 professional version. 

Components Explanation

Message Logger

Trace Recorder

Editors for structured text (ST)

function plan (FBD)

instruction list (IL)

ladder diagram (LD)

sequential function chart (SFC)

Continuous Function Chart (CFC)

Visualization commissioning visualization

Configurators PROFIBUS-DP master and slave

CANopen master and slave

IEC libraries

- Standard.lib standard IEC library with elementary functions (e.g. 
counter, string functions, timer, etc.)
PacDrive™ EPAS-4 page 11
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Table 3-1: Overview of components for EPAS-4

- MAx-4.lib interface library for
- AxisBuf functions
- COM IEC functions
- control functions
- diagnosis
- encoder manipulations
- file services
- IEC task
- message logger
- overload functions
- standard VarioCam® motion functions
- system functions
- measuring functions (touchprobe)

- Check.lib interface library for checking ARRAYs, divide by zero, 
string functions (debugging functions)

- Basic.lib IEC library with motion functions. It is based on the 
functions of MAx-4.lib auf.

- IECsfc.lib use of IEC interfaces with SFC for V00.06.00 or higher

- CSpline.lib interface library for VarioCam® CSpline function to convert 
supporting point data into cam data online.

- TorqueCam.lib interface library for torque cams.

- CANL2.lib interface library for CAN layer 2

- CANopen_M.lib interface library for CANopen master

- CANopen_S.lib interface library for CANopen slave

- PBDP_M.lib interface library for PROFIBUS-DP master

- PBDP_S.lib interface library for PROFIBUS-DP slave

- DNet_S.lib interface library for Device Net slave (in 
preparation)

- HMI_pcs.lib interface library for connection to Lauer PCS

- HMI_Simatic.lib interface library for connection to Simatic

- ModBus.lib interface library for connection to ModBus

- TSC.lib interface library for connection to ModBus (see also 
Operating Manual HMI Libraries)

- remote diagnosis modem connection EPAS-4 <-> MAx-4

Components Explanation
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Table 3-2: EPAS-4 order numbers and variants

3.3  Overview of EPAS-4 functionality

3.3.1  How is a project structured?

EPAS-4 differentiates between the different kinds of objects in a 
project: POUs, data types, display elements (visualisations) and 
resources.

The Object Organiser contains a list of all the objects in your 
project.

3.3.2  How do I set up my project?

First you should configure your PLC in order to check the accuracy 
of the addresses used in the project.

Then you can create the POUs needed to solve your problem.

Now you can program the POUs you need in the desired 
languages.

Once the programming is complete, you can compile the project 
and remove errors if there should be any.

3.3.3  How can I test my project?

Once all errors have been removed, log in to the PLC and "load" 
your project in the PLC. Now EPAS-4 is in Online mode.

Now open the window with your PLC Configuration and test your 
project for correct sequence. To do this, enter input variables 
manually and observe whether outputs are as expected. You can 
also observe the value sequence of the local variables in the POUs. 
In the Watch and Receipt Manager you can configure data records 
whose values you wish to examine.

Order number Product name Explanation

20 63 00 31 -001 EPAS-4 professional company licence

20 63 00 31 - 003 EPAS-4 upgrade basic to 
professional

company licence

20 63 00 31 - 004 EPAS-4 upgrade professional to new 
version

company licence

20 63 00 31 - 005 EPAS-4 professional for end user single licence
PacDrive™ EPAS-4 page 13
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3.3.4  Debugging with EPAS-4

In case of a programming error you can set breakpoints. If the 
process stops at such a breakpoint, you can examine the values of 
all project variables at this point in time. By working through 
sequentially (single step) you can check the logical correctness of 
your program.

3.3.5  Additional online functions

An additional EPAS-4 debugging function: You can set program 
variables and inputs and outputs at certain values. You can use the 
flow control to check which program lines have been run. The 
Sampling Trace allows you to trace and display the actual course of 
variables over an extended period of time. 

3.3.6  Conclusion

EPAS-4 is a complete development tool used to program your PLC 
which will save you a measurable amount of time setting up your 
applications.
P
D

M
_O

p

page 14  EPAS-4 PacDrive™

This document provided by Barr-Thorp Electric Co., Inc.   800-473-9123    www.barr-thorp.com



P
D

M
_O

pM
aE

P
A

S
4_

04
_

us
.F

M
Installation of EPAS-4

K
or

re
kt

ur
au

sd
ru

ck
4 Installation of EPAS-4

4.1  System requirements

Before installing EPAS-4, please check if your system meets the 
following minimum requirements.

minimum requirements

Windows 98, Windows NT 4.0 (Service Pack 5 or higher recom-
mended) or Windows 2000/XP Prof.

Pentium 200 MMX or higher

64 MB RAM

free serial interface or TCP/IP network connection (10 Mbps)

free hard disk memory > 100 MB

colour screen with a resolution of 800x600 pixel

CD-ROM drive

recommended configuration

Windows 2000/XP Prof. or Windows NT 4.0 (Service Pack 5 or 
higher recommended)

Pentium II 350 or higher

128 MB RAM

free serial interface and TCP / IP network connection (10 Mbps)

free hard disk memory > 500 MB

colour screen with a resolution of 1024x768 pixels

CD-ROM drive

4.2  Installation procedure

4.2.1  Method

NOTE

Switch off the energy saving mode of your PC. Otherwise communi-
cation errors may occur between EPAS-4 and MAx-4 PacController.

How to install EPAS-4:
Insert the PacControl CD into the CD-ROM drive of your PC.

The PacControl CD menu will be startet automatically.

Click on the button "Software".
PacDrive™ EPAS-4 page 15
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The installation starts with the dialog window "Choose Setup 
Language".

Follow the instructions of the installation program.

NOTE

To install EPAS-4 on a PC with Windows NT / Windows 2000/XP 
operating system, you need administrator rights. If necessary, con-
tact your system administrator.

You can also proceed as follows:
Select “Run...“ from the start menu.

In the dialog window "Run" enter the following line:
d:\setup.exe(if d: is your CD-ROM drive)

The installation starts with the dialog window "Choose Setup 
Language".

Follow the instructions of the installation program.

4.3  Starting EPAS-4

Double-click with the left mouse button on the EPAS-4 icon on 
your desktop.

NOTE

Please check whether the following settings exist in "Project->Opti-
ons->Directories" under the field name "Common" and adjust them, 
if necessary:
Libraries: C:\Program Files\ELAU\EPAS-4\V14\Library\
Compilation files: C:\Program Files\ELAU\EPAS-4\V14\Obj\

4.4  Language settings in Windows NT

NOTE

If you want to change the language in Versions earlier then V14, a 
project must be opened.

Dialog boxes provided by the functions of the operating system will 
remain in the Language of the operating system.
page 16  EPAS-4 PacDrive™
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5 Communication EPAS-4 / MAx-4 
PacController

5.1  Principle of Communication 

In principle, there are two ways of establishing a connection 
between EPAS-4 and MAx-4 Pac-Controller:

serial or

TCP / IP

The principle of how to establish a connection is always the same.

Fig. 5-1: Principle of communication

NOTE

As all connections, both serial and TCP/IP, are done via the gate-
way server, the PC must have a network card, or a virtual network 
card must be set up.
In versions 00.06.00 or higher, a serial connection can be esta-
blished without a network card and without TCP/IP on the EPAS-4 
PC. To do this, you need to select Gateway -> local when setting up 
a communcation channel in EPAS-4.

The further steps are described separately for Win 98 and Win NT 
(or Windows 2000/XP Prof.).
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NOTE

The TCP/IP address can be an internet address (e.g. 
190.205.100.1) or a symbolic name (e.g. max-4-pc-01) "target 
name". The target name must be an unique name for an also 
unique IP address. If a target name is used, it must be entered in 
the “hosts“ file in the “Windows“ directory, so that the target name 
can be allocated to the corresponding IP address.
It is common usage that the IP address 127.0.0.1 corresponds to 
the target name localhost. This is always your own computer.
Example for "hosts" file:
127.0.0.1 localhost
190.205.100.1 max-4-pc-01

5.2  Set up TCP/IP Protocol on the PC

5.2.1  Operating System Windows 98

(A) Set up "virtual" network device

(if you have a network device, you can skip this point)

Fig. 5-2: Control Panel Win 98

From the "Control Panel", select "Network".
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Fig. 5-3: Panel / Network Win 98

In the dialog window "Network" select "Add" 
(If there is already a Dial-Up Adapter installed proceed with (B).)

Fig. 5-4: Control Panel / Network / Add network card

Now select "Adapter" and then click on "Add...".
PacDrive™ EPAS-4 page 19
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Under "Microsoft", select "Dial-Up Adapter".

Fig. 5-5: Control Panel / Network / Select network card

In the selection field "Manufacturers" choose "Microsoft"

In the selection field Network Adapters click on "Dial-Up Adapter".

Confirm with "OK".

(B) Set up TCP/IP protocol

Fig. 5-6: Control Panel Win 98

From the "Control Panel", select "Network".
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Fig. 5-7: Control Panel / Network Win 98

In the dialog window "Network" select "Add...".
(If the TCP/IP protocol is already installed proceed with (C).)

Fig. 5-8: Control Panel / Network / add protocol

Select "Protol" and then click on "Add...".
PacDrive™ EPAS-4 page 21
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Fig. 5-9: Control Panel / Network / select protocol

Under "Manufacturers", select "Microsoft"

Under "Network Protocols" select "TCP/IP".

Confirm with "OK".

In the dialog window "Network", confirm again with "OK".

The message “Please insert your Windows CD“ appears.

Insert the Windows CD into the CD Rom drive.

Some files will be copied from the Windows installation CD to 
the PC.

Now you will be asked to restart your computer.
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(C) Properties of TCP/IP

Fig. 5-10: Control Panel / Network / TCP/IP Protocol / Properties

In the dialog window "Network" doubleclick the TCP/IP protocol. 

Select "Specify an IP address"

In the input field "IP Addess" enter the desired IP address.

NOTE

You will have to ask your system administrator or IT department for 
the IP address of your computer!
If you connect a computer to a MAx-4 PacController via TCP/IP 
network directly via the RJ45 cable (without network), you can use 
any IP address. But you may not use identical IP adresses! The 
same goes for a connection via the RS 232 interface with MAx-4.

In the input field "Subnet Mask", enter e.g. 255.255.0.0 (depen-
ding on the network).

Under the Gateway tab, enter the gateway number.

NOTE

You will have to ask your system administrator or IT department for 
the gateway number!

Confirm with OK.

In the network configuration, click OK.

Restart the computer.
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5.2.2  Operating system Windows NT 4.0 

(A) Set up "virtual" network card (RAS service)

(if you have a network card, you can skip this point)

Fig. 5-11: Control Panel Win NT

From the Control Panel, select Network.

Fig. 5-12: Control Panel / Network Win NT

In the "Network" dialog box, select "Add..." under "Services", if 
there is no Remote Access Service installed. (Else proceed with 
(B).)
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Fig. 5-13: Control Panel / Network / RAS service

Now select RAS Service (Remote Access Service) and confirm 
with OK.

(B) Set up TCP / IP protocol

Fig. 5-14: Control Panel Win NT

From the Control Panel, select Network.
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Fig. 5-15: Control Panel / Network / add protocol 

In the "Network" dialog box, select "Add..." under "Protocols", if 
no TCP/IP protocol has been set up (else proceed with (C).)

Fig. 5-16: Control Panel / Network / Select Network Protokol

Select TCP/IP protocol and confirm with OK.

Click again on the button OK.

The message "Please insert your Windows CD" appears.

Insert the Windows CD in your CD drive.

Some files will be copied from the Windows installation CD to 
the PC. 
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(C) Properties for TCP/IP

In the "Network" dialog window, mark the TCP/IP protocol and 
click on the button "Properties".

Select the TCP/IP protocol and click on Properties.

Fig. 5-17: Properties TCP/IP

Select the desired network card (if several cards are installed). 

Select "Specify an IP address. 

Select the input field "IP address".

Enter the IP address. 

NOTE

You will have to ask your system administrator or IT department for 
the IP address of your computer!
If you connect a computer to a MAx-4 PacController via TCP/IP 
protocol directly via RJ45 cable (without network), you can use any 
IP addresses. But you may not use identical IP adresses! The 
same goes for a connection via the RS 232 interface with MAx-4.

In the input field "Subnet Mask", enter e.g. 255.255.0.0 (depen-
ding on the network).

In the "Default Gateway" field, enter the gateway number. 
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NOTE

You will have to ask your system administrator or IT department for 
the gateway number!

Click OK. 

In the network configuration, click OK.

Restart the computer.

5.2.3  Operating system Windows 2000/XP Professional

To use EPAS-4 with Windows 2000/XP Prof. you don´t have to do 
any additional installation. The network protokol TCP/IP is aktivated 
as a standard.

5.3  Checking the TCP/IP Connection

Check the proper installation of the network connection. Make sure 
that the connection between the PacController MAx-4 and the PC 
has been established via Ethernet. First start to send a request to 
the PC:

Change to MS-DOS promt. 

Enter the command “ping 127.0.0.1“ (see picture below). Enter 
IP address without leading zeroes.

Fig. 5-18: MS DOS prompt
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If the reply is as shown in the picture, the TCP/IP connection to 
your own computer (localhost) is up and running.

Fig. 5-19: MS DOS prompt / ping

Now enter the command "ping localhost".

"Ping" now additionally shows its own PC identification. 

If the reply is as shown in the picture, the basic TCP/IP 
connection has been established.

If a connection to the MAx-4 is to be established via TCP/IP 
protocol, now ping the standard address 190.201.100.100 of the 
MAx-4.

NOTE

The factory default IP address of the PacController MAx-4 is 
"190.201.100.100".
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Fig. 5-20: MS DOS prompt / ping error

If, as shown in the picture, there is no reply from the PacController 
MAx-4, check the physical connection.
See also Checking the Physical Connection, page  39.

If the MAx-4 replies correctly, you can now start connecting the 
MAx-4 to a network, if you wish to integerate it in a network. If the 
MAx-4 is operated as a stand-alone unit, you can now 
establish the connection in EPAS-4 (see Kapitel: 5.4 Setting up the 
Gateway Server).

If there is no reply from the MAx-4, this can be due to the following 
reasons:

The IP address of the MAx-4 is not set to 190.201.100.100 

The physical connection to the MAx-4 is not correct.

NOTE

If the IP address of the MAx-4 is not known or no TCP/IP 
connection to the MAx-4 can be established, you should establish a 
serial connection to the MAx-4, and then read or change the IP 
address in the Control Configuration.
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5.4  Setting up the Gateway Server

5.4.1  Installation

The gateway server is automatically installed when installing EPAS-
4. All necessary EXE and DLL files of the gateway server are instal-
led in the Windows system directory.

NOTE

In case of problems (e.g. no connection with localhost), check 
whether the following files can be found in the Windows system 
directory:

CommSym.dll

CommUsr.dll

Gateway.exe

GClient.dll

GDrvBase.dll

GDrvStd.dll

GSymbol.dll

GUtil.dll

5.4.2  Setting or Changing the Password 

With EPAS-4 versions 00.05.00 or higher, you can set a password 
for the gateway server. All clients that want to connect to the gate-
way server have to transmit the correct password. In EPAS-4, this 
is set in the dialog "Communication Parameters / Gateway".

The password for the gateway server is set on the computer on 
which the gateway server is installed.

To change the password do the following steps:

Fig. 5-21: Gateway server icon

Start the gateway server by starting EPAS-4.

Try to establish a connection.
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This action will automatically start the gateway server and an 
icon will appear in the task bar on the right hand side.

Click on the gateway server icon in the task bar with the right 
mouse button.

Select "Change password..." to open the following dialog box:

Fig. 5-22: Change gateway server password

The dialog window "EPAS-4 Gateway Server: Change password" 
opens.

Enter the current password in the input field "Current password". 
(If no password has been set, leave the field blank.)

Enter the new password at "New password" and "Confirm pass-
word" with "OK".

Fig. 5-23: Gateway connection: Password

When EPAS-4 first connects with the gateway, the password will be 
requested, if a password has been allocated. Login is only possible 
with the correct password.

NOTE

If you fogot the password, contact a member of our application 
department.
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5.5  Setting up a Communication Channel 

5.5.1  Establish Connection with Gateway Server 

If EPAS-4 has not been installed, first install EPAS-4 using the 
setup program.

Start EPAS-4 via the file manager or the shortcut on the desktop.

Create a new project by navigating to the menu "File" and choose 
"New" (this opens the Communication Parameter dialog).

or

in the menu "Online" choose "Communication Parameters..." 
while a project is open.

The following dialog appears.

Fig. 5-24: Communication parameter dialog

If the TCP/IP protocol has been set up correctly, as described in the 
above chapters, the entry "localhost" will appear under “Channels“. 
This channel is connected with the gateway server on your own 
computer.
Opening the dialog box also starts the gateway server on the com-
puter (three honeycombs in the task bar on the right hand side).

NOTE

If you get a message "localhost (not connected)", EPAS-4 could not 
establish a connection with the gateway server. This can be due to 
several reasons:

The TCP/IP protocol has not been set up correctly. Check the 
configuration of the TCP/IP protocol.

Gateway.exe cannot be found in the folder "..\Windows\System".
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5.5.2  Set up New TCP/IP Connection

Select "New..." in the "Communication Parameters" window.

The following dialog box will appear.

Fig. 5-25: Communication parameter: New channel

Change name to a significant name, e.g. as shown below.

Fig. 5-26: Communication parameter: New channel / Name

Click the "OK" button.

Under "localhost", the entry is inserted as follows:

Fig. 5-27: "Communication parameter: New channel" inserted
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How to change the IP address:

Click on the Value "190.201.100.100" (‘Fig. 5-27: ) in the 
“Address“ line. The address will be marked.

Double-click to change it to an input field in which you can 
change the IP address.

Complete the entry by pressing the return button or clicking out-
side the entry field.

Port must be set to 5000 (standard setting; do not change), Moto-
rola byteorder is "No".

5.5.3  Set up New Serial Connection

Select "New..." in the "Communication Parameters" window.

The following dialog box will appear:

Fig. 5-28: Communication parameter: New channel

In the "Name" field change the name to a significant name, e.g. 
as shown below.

Fig. 5-29: Communication parameter: New channel / Name

From the "Device" tab choose "Serial (RS232)".

Click the "OK" button.
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Fig. 5-30: Communication parameter

The new connection will be entered under "localhost".

For the serial interface COM1 standard settings are given and 
should not be changed here. To choose a different interface (e.g. 
COM2), change the column “Value“ in the line "Port".

NOTE

The communication parameter dialog box will automatically detect 
the available COM ports and display them, i.e. if only COM1 and 
COM2 are available on the PC, only COM1 and COM2 will be shown.

5.5.4  Selecting the Connection

Fig. 5-31: Communication parameters

In the left field, select the connection (marked in blue).

Click the "OK" button.
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Fig. 5-32: Input assistant for TCP/IP parameters

The input assisstant for entering TCP/IP parameters will appear 
(V00.10.00 or higher).

Confirm with "Finishing".

In the menu "Online" choose menu item "Login" to establish a 
connection to the PacController MAx-4.

Fig. 5-33: Dialog: Establish connection with MAx-4

If the above box appears, the connection with the MAx-4 Pac-
Controller has been set up and established.

The gatway server will indicate an active connection in the task 
bar (three honeycombs in light color).

Fig. 5-34: Dialog: Communication error

The above dialog box will appear if no connection could be esta-
blished with the MAx-4 PacController. 

Quit the dialog box and check the following settings:

– In case of serial connection check the serial connection set-
tings, such as port, baud rate, etc.

– In case of TCP/IP connection check the settings for IP 
address, port, etc. 
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5.5.5  Selecting a Connection Globally or in the Project 

If a connection to the MAx-4 PacController could be established 
with a selected connection, the Gateway server will add it to the 
Windows registry. It will be shown in an indented line under “Chan-
nels“ in the Communication Parameter dialog (see below).

Fig. 5-35: Communication parameter

The entries under localhost are stored in the Windows registry of 
the computer. The other entries are stored in the project.

To create the communication connection in the project, make your 
selection, confirm with OK and save the project. If a connection 
could be established, it is stored in the windows registry.

NOTE

If you are using the indented connection and want to transfer the 
project to another computer, make sure that the connection is 
already stored in the registry of that computer. Otherwise a commu-
nication error will occur if you open the project and establish an 
online connection.

NOTE

If there are two connections with different names that uses the 
same COM port or IP address, no second connection will be stored 
in the registry.
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5.5.6  Delete Connection Entries

If a connection is no longer needed, delete it in the Communication 
Parameter dialog, using the button “Delete“.

NOTE

There will be no safety check. The delete action cannot be 
reversed. In this case, you will have to set up the connection anew.

5.5.7  Setting up a New Gateway

If the gateway server is located on another computer, you will have 
to enter the IP address of the computer on which the gateway 
server has been set up.

For this purpose:

Click on the "Gateway" button in the "Communication Parame-
ters" dialog window. 

The following dialog box appears.

Fig. 5-36: Dialog: Communication parameter: Gateway

In ther "Address" field, enter the symbolic name of the gateway 
or the IP address. (Do not change the entries under "Data Port" 
and "Service Port".)

Under "Passwort", enter the password of the gateway, if a pass-
word was set in the gateway server on the other computer.

5.6  Checking the Physical Connection 

In case of communication problems, check the following points of 
the physical connection:

Was the network card inserted correctly in the PC and is it 
working?

Are the plug and socket connections okay?
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Is the network cable okay?

In case of BNC connection:

– Are the terminal resistors in place?

In case of RJ45 connection on the PC:

– Is the hub okay?

– Is the hub carrying voltage?

– Is the RJ45 cable correct (transposed/non-transposed ver-
sion?)

5.7  Connector Occupation of the RS232 Interface 

Fig. 5-37: Connector occupation of the RS232 interface
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6 Working with EPAS-4

6.1  Project Components

The following chapters contains the most importent terms to faci-
litate the EPAS-4 introduction.

6.1.1  Project

A project contains all of the objects in a PLC program. A project is 
saved in a file named after the project. The following objects are 
included in a project:

POUs (Program Organisation Units), data types, visualisations, 
resources, and libraries.

6.1.2  POU (Program Organisation Unit)

Functions, function blocks and programs are POUs.

Each POU consists of a declaration part and a body. The body is 
written in one of the IEC programming languages, which include IL, 
ST, SFC, FBD, LD and CFC.

EPAS-4 supports all IEC standard POUs. If you want to use these 
POUs in your project, you must include the library standard.lib in 
your project.

POUs can call up other POUs. However, recursions are not 
allowed.

6.1.3  Function

A function is a POU which yields exactly one data element (which 
can consist of several elements, such as fields or structures) when 
it is processed, and whose call in textual languages can occur as 
an operator in expressions.

When declaring a function, do not forget that the function must 
receive a type. This means that, after the function name, you must 
enter a colon followed by a type.

A correct function declaration can look like this example:
FUNCTION Fct:INT

In addition, a result must be assigned to the function. That means 
that function name is used as an output variable.

A function declaration begins with the keyword FUNCTION and 
ends with END_FUNCTION.
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Example in IL of a function that takes three input variables and 
returns the product of the first two divided by the third:

Fig. 6-1: Function

The call of a function in ST can appear as an operand in 
expressions. 

Functions do not have any internal conditions. That means that cal-
ling up a function with the same argument (input parameters) 
always produces the same value (output).

Example Calling up the function described above:

in IL

LD 7

Fct 2,4

ST Result

in ST
Result := Fct(7, 2, 4);

in FBD

In SFC a function call can only take place within a step or a 
transition.

NOTE

If you define a function in your project with the name CheckBounds, 
you can use it to check for range overflows in your project! If you 
define a function in your project with the name CheckBounds, you 
can use it to check for range overflows in your project! The name of 
the function is defined and may have only this identifier. An 
example of how this function is implemented is shown below:
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Fig. 6-2: Example of the Implementation of the CheckBounds

The following typical program for testing the CheckBounds function 
goes beyond the boundaries of a defined array. The CheckBounds 
function makes sure that the value TRUE is not assigned to the 
position A[10], but rather to the upper area boundary A[7] which is 
still valid. Therefore, the CheckBounds function can be used to cor-
rect extensions beyond array boundaries..

Fig. 6-3: Program for the CheckBounds Function

6.1.4  Function block

A function block is a POU which provides one or more values 
during the procedure. As opposed to a function, a function block 
provides no return value.

A function block declaration begins with the keyword 
FUNCTION_BLOCK and ends with END_FUNCTION_BLOCK.
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Example in IL of a function block with two input variables and two 
output variables. One output is the product of the two inputs, the 
other a comparison for equality:

Fig. 6-4: Function Block

Function Block
Instances

Reproductions or instances (copies) of a function block can be 
created.

Each instance possesses its own identifier (the instance name), 
and a data structure which contains its inputs, outputs, and internal 
variables. Instances are declared locally or globally as variables, 
whereas the name of the function block is indicated as the type of 
an identifier.

Example of an instance with the name INSTANCE of the FUB 
function block:

INSTANCE: FUB;

Function blocks are always called through the instances described 
above.

Only the input and output parameters can be accessed from outside 
of an function block instance. This means the internal variables of 
the function blocks remain invisible to the user of the function block.

Example - Accessing an input variable:

The function block FB has an input variable in1 of the type INT.
PROGRAM prog

VAR

inst1:fb;

END_VAR

LD 17

ST inst1.in1

CAL inst1

END_PROGRAM

The declaration parts of function blocks and programs can contain 
instance declarations. Instance declarations are not permitted in 
functions.
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Access to a function block instance is limited to the POU in which it 
was declared unless it was declared globally.

The instance name of a function block instance can be used as the 
input for a function or a function block.

NOTE

All values are retained after processing a function block until the 
next it is processed. Therefore, function block calls with the same 
arguments do not always return the same output values!

Calling a
function block

You can use the variables of the function block by entering the 
instance name, a point, and then the variable name.

If you would like to set the input parameters when you open the 
function block, you can do this in the text languages IL and ST by 
assigning values to the parameters after the instance name of the 
function block in parentheses (this assignment takes place using 
":=" just as with the initialisation of variables at the declaration 
position).

Examples for calling function block FUB described above. The mul-
tiplication result is saved in the variable ERG, and the result of the 
comparison is saved in QUAD. An instance of FUB with the name 
INSTANCE is declared:

In IL the function block is implemented as follows:

Fig. 6-5: Function Block Call in IL
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In the screenshot below the call is shown in ST The declaration part 
is the same as with IL:

Fig. 6-6: Function Block in Call in ST

In FBD it would look as follows (declaration part the same as with 
IL):

Fig. 6-7: Function Block Call in FBD

In SFC function block calls can only take place in steps.

6.1.5  Program

A program is a POU which returns several values during operation. 
Programs are recognised globally throughout the project. All values 
are retained from the last time the program was run until the next.

Fig. 6-8: Example of a program

Programs can be called by programs and function blocks. A pro-
gram call in a function is not allowed. There are also no instances 
of programs.

If a POU calls a program, and if thereby values of the program are 
changed, then these changes are retained the next time the pro-
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gram is called, even if the program has been called from within 
another POU.

This is different from calling a function block. There only the values 
in the given instance of a function block are changed.

These changes therefore play a role only when the same instance 
is called.

A program declaration begins with the keyword PROGRAM and 
ends with END_PROGRAM.

Examples: Calls of the program described above:

In IL:

CAL PRGExample

LD PRGexample.PAR

ST ERG

in ST:

PRGExample;

Erg := PRGexample.PAR;

In FBD::

Example: A possible call sequence for PLC_PRG:

LD 0

ST PRGexample.PAR(*Default setting for PAR is 0*)

CAL IL call(*ERG in IL call results in 1*)

CAL ST call(*ERG in ST call results in 2*)

CAL FBD call(*ERG in FBD call results in 3*)

If the variable PAR from the program PRGexample is initialised by 
a main program with 0, and then one after the other programs are 
called with above named program calls, then the ERG result in the 
programs will have the values 1, 2, and 3. If one exchanges the 
sequence of the calls, then the values of the given result parame-
ters also change in a corresponding fashion.

PLC_PRG The PLC_PRG is a special predefined POU. This POU is triggered 
all 10 ms (from V00.10.00), if you don´t use the task configuration.

The first time the PROJECT | OBJECT | ADD command is used 
after a new project has been created, the default entry in the POU 
dialog box will be a POU named PLC_PRG of the program type. 
You should not change this default setting!

If tasks have been defined, then the project may not contain any 
PLC_PRG, since in this case the procedure sequence depends 
upon the task assignment.
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NOTE

The POU PLC_PRG should not be used by you in the normal case. 
Use the Taskkonfiguration to steer the program-calls.

6.1.6  Resources

You need the resources for configuring and organising your project 
and for tracing variable values:

Global Variables which can be used throughout the project

Message logger to show and archive system messages and dia-
gnostic messages

PLC Configuration for configuring your hardware

Task Configuration for guiding your program through tasks

Sampling Trace for graphic display of variable values

VarioCam functions to execute motion tasks

Watch and Receipt Manager for displaying variable values and 
setting default variable values

Library manager

Log

More information concerning resources see the online help section 
"The Resources".

6.1.7  Libraries

You can include in your project a series of libraries whose POUs, data 
types, and global variables you can use just like user-defined varia-
bles. The library "Standard_V00XXXX.lib" and "MAX4_V00XXXX.lib" 
are a standard part of the program and are always at your disposal.

More information concerning libraries see the online help section 
"Library Manager".

6.1.8  Data types

Along with the standard data types the user can define his own data 
types. Structures, enumeration types and references can be 
created.

More information concerning data types see the online help sec-
tions "Standard" and "Defined data types".
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6.1.9  Visualization

EPAS-4 provides visualisations so that you can display your project 
variables. You can draw geometric elements off-line with the help of 
the visualization. They can then change their form online, depen-
ding upon certain variable values. 

6.2  Help When You Need It

Should you encounter any problems with EPAS-4 during your work, 
online help is available to help to solve them. There you will find all 
the information contained in this manual.

The Help menu

The menu "help" contains the "contents..." command to open the 
help topics window. 

Fig. 6-9: EPAS-4 Windows Help

The help window is divided into three main components. The navi-
gation bar, the navigation window and the text window. You don´t 
have to switch between navigation window and text window like 
earlier help systems.

The "Contents" tab displays the chapters of the help file in a folder 
structure. You can open or close the books by a double click.

With a click on a specific topic its content will be displayed in the 
text window.
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A click on the Index tab shows a input field to search for a keyword 
and with a click on the search tab you can perform a fulltext search.

Windows help buttons

The following buttons are available:

"Help topics" opens the help topics window

"Back" shows the help entry displayed previously

"Print" opens the dialog box for printing

"<<" shows the help entry that comes prior in sequence to the 
present entry

">>" shows the help entry that is next in sequence

In addition you can use the following menu commands:

With "File" -> "Print Topics" command you can print out the pre-
sent help entry.

If you use the "Edit" -> "Copy" command, the selected text will 
be copied to the clipboard. From here you can insert the text into 
other applications and use it there.

If you use the "Edit" -> "Annotate" command, a dialog box will be 
opened. There is an editing field on the left side of the dialog box 
in which you can enter an annotation to the help page. On the 
right side there are buttons for storing the text, for cancelling the 
program, for deleting the notation, for copying a highlighted text 
to the clipboard, and for pasting a text from the clipboard. If you 
have made an annotation to a help entry, a small green paper 
clip will appear in the upper left-hand corner. By clicking the 
mouse on the paper clip, you can open the dialog box with the 
annotation that has been made.

If you would like to mark a page from help, then you can set a 
bookmark. To do so, in the menu "Bookmark" choose the 
"Define" command. A dialog box will appear in which you can 
enter a new name (The name of the page can serve as a starter) 
or can delete an old bookmark. If bookmarks were defined, then 
these will be displayed in the "Bookmark" menu. By choosing 
these menu items, you can access the desired page.

Under "Options", you can define whether the help window 
always appears in the foreground  or in the background or in the 
standard setting.

With the command "Display Previous Topics" under "Options", 
you are furnished with a selection window with the previously 
displayed help topics. Double-click the entry you wish to view.

Under "Options", you can select the desired "Font" in small, nor-
mal, or large.
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If "Options" -> "Use System Colors" has been chosen, help will 
not be displayed in the colours that were set, but in the system 
colours instead.

Context Sensitive Help

Shortcut: <F1>

You can use the <F1> key in an active window, in a dialog box, or 
above a menu command. When you perform a command from the 
menu, the help for the command called up at that time is displayed. 

You can also highlight a text (for example, a key word or a standard 
function) and have the help displayed for that item.

6.3  Adaptation of EPAS-4 to PacController MAx-4 
Firmware Version

6.3.1  Manually Adaption of the Firmware (V00.11.00 and 
higher)

The EPAS-4 Version 00.11.00 and higher contains a command to 
choose the firmware version under "Extras" -> "Select MAx4 
Version...". 

You can only switch to an other firmware if there is no project ope-
ned in EPAS-4.

6.3.2  Automatically Adaption of EPAS-4 to MAx-4 Firmware 

When logging into the MAx-4 PacController, EPAS-4 recognizes 
the firmware version and automatically adapts to it. However, you 
will have to end EPAS-4 and restart it.

Fig. 6-10: Dialog to adjust firmware versions
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6.3.3  EPAS-4 Does Not Support MAx-4 Firmware

The first four digits of the EPAS-4 firmware version must be equal 
to or greater than the firmware version of the MAx-4 PacController.

If this is not the case, the following error message will be generated 
when logging into the MAx-4 PacController.

Fig. 6-11: Dialog if firmware version is not supported

NOTE

Description files are files stored in the ConfigFiles directory

Table 6-1: Examples for firmware compatibility

6.4  Using the Keyboard

6.4.1  Shortcuts

If you would like to run CoDeSys using only the keyboard, you will 
find it necessary to use a few commands that are not found in the 
menu.

The function key <F6> allows you to toggle back and forth within 
the open POU between the Declaration and the Instruction 
parts.

<Alt>+<F6> allows you to move from an open object to the 
Object Organiser and from there to the Message window if it is 
open. If a Search box is open, <Alt>+<F6> allows you to switch 
from Object Organiser to the Search box and from the there 
back to the object.

EPAS-4 PacController MAx-4

00.10.00 00.10.00 OK

00.07.00 00.10.00 update EPAS-4 version!
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Press <Tab> to move through the input fields and buttons in the 
dialog boxes.

The arrow keys allow you to move through the register cards 
and objects within the Object Organiser and Library Manager.

All other actions can be performed using the menu commands or 
with the shortcuts listed after the menu commands. <Shift>+<F10> 
opens the context menu which contains the commands most fre-
quently used for the selected object or for the active editor.

6.4.2  Key Combinations

The following is an overview of all key combinations and function 
keys:

Table 6-2: Key combinations for general operation

General Functions Keys

Move between the declaration part an the 
instruction part of a POU

<F6>

Move between the Object Organiser, the object 
and the message window

<Alt> + <F6>

Context Menu <Shift> + <F10>

Shortcut mode for declarations <Ctrl> + <Enter>

Move from a message in the Message window 
back to the original position in the editor

<Enter>

Open and multi-layered variables <Enter>

Open and close folders <Enter>

Switch register cards in the Object Organiser 
and the Library Manager

<Arrow keys>

Move to the next field within a dialog box <Tab>

Context sensitive Help <F1>
PacDrive™ EPAS-4 page 53

This document provided by Barr-Thorp Electric Co., Inc.   800-473-9123    www.barr-thorp.com



P
D

M
_O

pM
aE

P
A

S
4_

06
_

us
.F

M

Working with EPAS-4

K
or

re
kt

ur
au

sd
ru

ck
Table 6-3: Key combinations for general commands

General Commands Keys

„File“ „Save“ <Ctrl>+<S>

„File“ „Print“ <Ctrl>+<P>

„File“ „Exit“ <Alt>+<F4>

„Project“ „Delete Object“ <Del>

„Project“ „Add Object“ <Ins>

„Project“ „Rename Object“ <Spacebar>

„Project“ „Open“ <Enter>

„Edit“ „Undo“ <Ctrl> + <Z>

„Edit“ „Redo“ <Ctrl> + <Y>

„Edit“ „Cut“ <Ctrl> + <X> or <Shift> + 
<Del>

„Edit“ „Copy“ <Ctrl> + <C>

„Edit“ „Paste“ <Ctrl> + <V>

„Edit“ „Delete“ <Del>

„Edit“ „Find next“ <F3>

„Edit“ „Input Assistant“ <F2>

„Edit“ „Next Error“ <F4>

„Edit“ „Previous Error“ <Shift> + <F4>

„Online“ „Run“ <F5>

„Online“ „Toggle Breakpoint“ <F9>

„Online“ „Step over“ <F10>

„Online“ „Step in“ <F8>

„Online“ „Single Cycle“ <Ctrl> + <F5>

„Online“ „Write Values“ <Ctrl> +<F7>

„Online“ „Force Values“ <F7>

„Online“ „ Release Force“ <Shift> + <F7>

„Window“ „Messages“ <Shift> + <Esc>
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Table 6-4: Key combinations for commands of the FBD editor 

Table 6-5: Key combinations for commands of the LD editor

FBD Editor Commands Keys

„Insert“ „Network (after) <Shift> + <T>

„Insert“ „Assignment <Ctrl> + <A>

„Insert“ „Jump“ <Ctrl> + <L>

„Insert“ „Return“ <Ctrl> + <R>

„Insert“ „Operator“ <Ctrl> + <O>

„Insert“ „Function“ <Ctrl> + <F>

„Insert“ „Function Block“ <Ctrl> + <B>

„Insert“ „Input“ <Ctrl> + <U>

„Extras“ „Negate“ <Ctrl> + <N>

„Extras“ „Zoom“ <Shift> + <Enter>

LD Editor Commands Keys

„Insert“ „Network“ (after) <Shift> + <T>

„Insert“ „Contact“ <Ctrl> + <O>

„Insert“ „Parallel Contact <Ctrl> + <R>

„Insert“ „Function Block“ <Ctrl> + <B>

„Insert“ „Coil“ <Ctrl> + <L>

„Extras“ „Paste below <Ctrl> + <U>

„Extras“ „Negate“ <Ctrl> + <N>
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Table 6-6: Key combinations for commands of the SFC editor

Table 6-7: Key combinations for operating the control configuration 

Table 6-8: Key combinations for operating the task configuration 

6.5  Special settings in EPAS-4.ini

EPAS-4.ini is an initialization file for EPAS-4. The standard settings 
of EPAS-4 can be modified here. The EPAS-4.ini file is stored in the 
program folder. Using versions earlier than V00.11.00 you can find 
the EPAS-4.ini in the Windows directory (e.g. C:\Windows).

Almost every data entry you modify in the EPAS-4.ini, you can also 
change very easy via the menu "Project" -> "Options" in EPAS-4 
and that should be the preferred way. Anyhow, if you modify the file, 
make sure not to damage the file by incorrect data entries. Always 
create a copy of the EPAS-4.ini before you modify it.

SFC Editor Commands Keys

„Insert“ „Step-Transition (before)“ <Ctrl> +<T>

„Insert“ „Step-Transition (after) <Ctrl> +<E>

„Insert“ „Alternative Branch (right)“ <Ctrl> +<A>

„Insert“ „Parallel Branch (right)“ <Ctrl> +<L>

„Insert“ „Jump“ (SFC) <Ctrl> +<U>

„Extras“ „Zoom Action/Transition“ <Alt> +<Enter>

Move back to the editor from the SFC Overview <Enter>

Work with the PLC Keys

Open and close organisation <Enter>

Place and edti control box around the name <Spacebar>

„Extras“ „Edit Entry“ <Enter>

Work wirth the Task Configuration Keys

Place an edit control box around the task or 
program name

<Spacebar>
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Below you will find a list of the most important entries:

Keyword Default Description

Autodeclare no automatic variable declaration

Autoformat Yes automatic formating

Autoload Yes automatically load last project 

Autosave No automatically store the project when 
compiling

AutosaveInterval 10 interval time for Autosave in minutes

AutoScroll Yes

Backup No backup copy

CompareDir empty directory for comparing projects

CompileDir empty compilation directory

DisplayMode 1 1=DEC_MODE; 2=BIN_MODE; 
3=HEX_MODE

DocuframeDir empty directory for document frames

Documentation-
Frame

DEFAULT.DFR document frame file

EPAS_Standard-
Timeout

5 standard communication timeout in 
seconds

EPAS_Extended-
Timeout

20 timeout for specific services 
- compare parameters 
(LZS_OBJ_VERIFY_PAR)
- set parameters (LZS_OBJ_SET_PAR)
- program download 
(LZS_BOOT_PROJECT)

EPAS_Comm-
Retries

3 number of tries when establishing 
communication

EPAS_FileTransferB
lockSize

4096 Block size for seriel file transfer

EPAS_RetainSize 1024 retain variable range (entry only up to 
V00.04.00, then in OV-INI RetainArea)

EPAS_Memory-Size 1024 marker range (default up to V00.07.00 = 
256)

EPAS_OutputSize 1024 output range

EPAS_ProgramFileD
ownload

Yes Setting for login dialog project file

EPAS_LogFileUpload Yes load message logger in case of error

EPAS_InputSize 1024 input range
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Table 6-9: Settings in EPAS-4.ini file

NOTE

The default value is always used if there is no entry in EPAS-4.ini.

EPAS_Segment-
Size

0x7FFF size of data segment

EPAS_DumpSource
Download

No load project sources into control

EPAS_SendASCIIS
ymbolFile

No transmit ASCII symbol file to gateway

EPAS_OnlineChange Yes

ImportExportDir empty import/export directory

Language German German
English

LibraryDir empty library directory

MaxNumOfPOUs 1024 max. number of Program Organisation 
Units

ProjectInfoAuto No automatically open project information 
dialog

ProjectsDir empty project directory

SDBVersion - Version of the created symbol file
0 = compatibility with V6/V7/SP2
(see also problem report)

TabWidth 4 tab width

TraceDir empty save/load trace directory

UserCompany empty company name for documentation

UserInitals empty initials for documentation

UserName empty name for documentation

WatchDir empty variable list directory

WatchPercent 50 width of variable window in percent

Keyword Default Description
P
D

M
_O

p

page 58  EPAS-4 PacDrive™

This document provided by Barr-Thorp Electric Co., Inc.   800-473-9123    www.barr-thorp.com



P
D

M
_A

nh
an

gS
td

_u
s.

F
M

7.1 Contact

K
or

re
kt

ur
au

sd
ru

ck
7 Appendix

7.1  Contact

For repair

Please send the components to be repaired or checked, along with 
the error report, to this address:

ELAU AG
Abt. Kundendienst house address:
Postfach 1255 Dillberg 12
97821 Marktheidenfeld 97828 Marktheidenfeld
Phone: +49 (0) 93 91 / 606-142
Fax: +49 (0) 93 91 / 606-340

Service team

Should you need to talk to a member of our service team or require 
on-site service, please contact:

ELAU AG
Dillberg 12
D-97828 Marktheidenfeld
Phone: +49 (0) 9391 / 606 - 0
Fax: +49 (0) 9391 / 606 - 300
e-mail: info@elau.de
Internet: www.elau.de

ELAU, Inc.
4201 West Wrightwood Avenue
Chicago, Illinois 60639 - USA
Phone: +1 773 342 8400
Fax: +1 773 342 8404
e-mail: sales@elau.com
Internet: www.elau.com

ELAU SYSTEMS ITALIA S.r.l.
Via Tosarelli 300
I-40050 Villanova di Castenaso (BO)
Phone: +39 051 / 7818 70
Fax: +39 051 / 7818 69
e-mail: info@elau.it
Internet: www.elau.it

NOTE

Further contact addresses you can find on the ELAU homepage 
(www.elau.de).
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7.2  Further Literature

ELAU can provide you with these manuals and instructions on the 
PacDrive™ System:

Project Manual

German Art.No. 17 13 00 58 - 000
English Art.No. 17 13 00 58 - 001
French Art.No. 17 13 00 58 - 003

Programming Manual

German Art.No. 17 13 00 61 - 000
English Art.No. 17 13 00 61 - 001

Operating Manual MC-4 MotorController

German Art.No. 17 13 00 62 - 000
English Art.No. 17 13 00 62 - 001
Italian Art.No. 17 13 00 62 - 002
French Art.No. 17 13 00 62 - 003

Operating Manual CAN L2

German Art.No. 17 13 00 66 - 000
English Art.No. 17 13 00 66 - 001

Operating Manual PROFIBUS-DP

German Art.No. 17 13 00 67 - 000
English Art.No. 17 13 00 67 - 001

Operating Manual SM Motor

German Art.No. 17 13 00 68 - 000
English Art.No. 17 13 00 68 - 001
Italian Art.No. 17 13 00 68 - 002
French Art.No. 17 13 00 68 - 003

Operating Manual EPAS-4

German Art.No. 17 13 00 70 - 000
English Art.No. 17 13 00 70 - 001

Operating Manual MAx-4 PacController

German Art.No. 17 13 00 71 - 000
English Art.No. 17 13 00 71 - 001
Italian Art.No. 17 13 00 71 - 002
French Art.No. 17 13 00 71 - 003

Operating Manual OPC-Server

German Art.No. 17 13 00 73 - 000
English Art.No. 17 13 00 73 - 001

Operating Manual Device Net

German Art.No. 17 13 00 76 - 000
English Art.No. 17 13 00 76 - 001
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Operating Manual HMI Libraries

German Art.No. 17 13 00 77 - 000
English Art.No. 17 13 00 77 - 001

Operating Manual INC-4 Incremental Encoder Module

German Art.No. 17 13 00 78 - 000
English Art.No. 17 13 00 78 - 001

Operating Manual CANopen

German Art.No. 17 13 00 79 - 000
English Art.No. 17 13 00 79 - 001

Operating Manual VarioCam® Editor ECAM-4

German Art.No. 17 13 00 80 - 000
English Art.No. 17 13 00 80 - 001

Operating Manual PacNet Module PN-4

German Art.No. 17 13 00 81 - 000
English Art.No. 17 13 00 81 - 001

Operating Manual SR Motor

German Art.No. 17 13 00 82 - 000
English Art.No. 17 13 00 82 - 001

Operating Manual BusTerminal BT-4/DIO1

German Art.No. 17 13 00 83 - 000
English Art.No. 17 13 00 83 - 001

Operating Manual TTS

German Art.No. 17 13 00 88 - 000
English Art.No. 17 13 00 88 - 001*

User Manual Automatic Controller Optimization

German Art.No. 17 13 00 89 - 000
English Art.No. 17 13 00 89 - 001

Operating Manual Servo Drive SCL

German Art.No. 17 13 00 93 - 000*
English Art.No. 17 13 00 93- 001*
Italian Art.No. 17 13 00 93- 002*

Operating Manual Power Supply PS-4

German Art.No. 17 13 00 94 - 000*
English Art.No. 17 13 00 94- 001*
Italian Art.No. 17 13 00 94- 002*

* = in preparation
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7.3  Product Training

We offer practical workshops and seminars.

Our experienced seminar leaders will enable you to make optimum 
use of the vast possibilities of the PacDrive™ system.

NOTE

Please contact us for further information or to order our seminar 
program. See also our homepage (www.elau.de).
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7.4  Modifications

07 / 1998

Manual created

03 / 2000

Manual restructured

Corrections of various mistakes and amendments

Update to Version 00.07.00

10 / 2000

Update to Version 00.10.00

04 / 2003

Correction of various mistakes and amendments

NOTE

The latest documentation, application notes and the revision ser-
vice for this product can be found on ELAU’s Homepage (http://
www.elau.de).
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7.5  Index

C
contact 59
contents 3

D
data types 48

E
ELAU AG

eMail 2
homepage 2
internet 2

F
function 41
function block 43

calling 45
function block instances 44

H
help 49

contents and index 49
help window 49

I
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K
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key combinations 53
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manuals 60
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W
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